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Direction : Add a suitable question tag for the Direction : In the following Question No. 3 a 
following sentence in Question No. 1. 

They haven't bought the cakes 
(1) 
(2) Had they? 
(3) 

Hadn't they? 

Have they? 
(4) Haven't they? 

Out of the four groups given, select the 
group/groups that consist of all correct 
opposites 
Group A 
beautiful,- ugly 
fair -unfair 
dry - wet 
careful - careless 

Group B 
friendly - unfriendly 
remember - forget 
able - unable 

qualify - disqualify 

Group C 
active - inactive 

vallid - unvallid 

leagal - illeagal 
happy - sad 

Group D 
correct - uncorrect 

suitable - unsuitable 

ambiguous - inambiguous 
accept - reject 

(1) A and D 

L-52-1_R 

(3) B and C 
(2) 
(4) 

C and A 

? 

A and B 

2 

sentence has been given in Direct/Indirect 
speech. Out of the four given alternatives, 
select the one which best expresses the same 
sentence in Indirect/Direct speech. 

3 

4 

5 

The mechanic : "The spare parts will be 
available tomorrow". 

(1) The mechanic said that the spare 
parts would be available the next 
day. 

(2) The mechanic said that the spare 
parts would have been available 
tomorrow. 

(3) The mechanic said that the spare 
parts are going to be available the 
next day. 

(4) The mechanic said that the spare 
parts would not be available the 
next day. 

Choose the correct verb form and fill in 
the blanks: 

One of my sisters 

(1) was 

(2) have 

(3) has 

(4) is 

Indians 

(1) believes 

(2) is believing 

(3) believe 

(4) are believed 

gone to America. 

in nonviolence. 

PT.0. 
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Direction : In the following questions 6 and 

7a sentence has been given in active/passive 

voice. Out of the four given alternatives, select 
the one. Which best expresses the same 

sentence in passive/active voice. 

6 

7 

The secretary passed on the information. 

(1) The information will be passed on 

by the secretary. 

(2) The infornmation was being passed 

on by the secretary. 

(3) The information was passed on by 

the secretary. 

(4) The informnation was to be passed 

on by the secretary. 

The child has torn to book.. 

(1) The book was torn by the child. 

(2) The book had been torn by the 

child. 

(3) The book has been torn by the child. 

(4) The book was being torn by the 
child. 

L-52-1 R 3 

Direction : Question No. 8 contains a 

paragraph of 6 sentences. The first and the 

sixth sentences are given in the beginning and 
end and numbered 1 to 6 respectively. The 
four sentences in the middle are jumbled and 

labeled as P, Q, R, S. You must identify the O 
proper order/arrangement of the sentences and 

shade/darken the option that correctly identifies 
this sequence. 

1. 

P 

Q. 

R. 

S. 

6. 

Rekha aspired to become a doctor. 
She was motivated by her love to 

help people. 

Her family was poor and could not 
afford to spend on a payment seat. 

However she was heart broken 

when she lost the seat by a mere O 

one mark. 

Her relatives advised her to give 

up and opt for engineering. 

She worked very hard day and night 
for the entrance exams. 

Nevertheless Rekha decided to 

persevere. She found it hard to give 
up her goal. 

(1) SQRP 

(2) QsRP 

(3) PSQR 

(4) SQPR 

4463119 
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Direction : Question Nos. 9 and 10 are 

designed to test your ability to use the r+gnt 
prefix. Add a prefix so that the word conveys 
the meaning given in the brackets. Choose the 

most appropriate answer from the alternatives 

to complete the word by adding the prefix and 

shade/blacken the corresponding circle 
accordingly in your Answer Sheet. 

9 

10 

The 

India is full of distorted details. 

(1) pre 

(2) un 

(3) mid 

(4) past 

to wrong decisions. 

(1) under 

adequate information may lead 

(2) over 

Independence history of 

(3) multi 

(4) in 

L-52-1 R 4 

Direction : For Question Nos. 11 to 13 

the sentence. You have to choose the sentence 
underlined idiom or phrase has been used in 

which explains the correct meaning of that 
and shade/blacken the corresponding circle 
accordingly in your Answer Sheet. 

11 

12 

13 

He /s in a fix whether to buy a mobile or 
a TV. 

(1) He will decide in due time to bring 
either of the items. 

(2) He is fixed on buying a mobile or 
a TV. 

(3) He has the money to buy either a 
mobile or a TV eventually. 

(4) He is undecided about buying a 
mobile or a TV. 

His death is a cold-blooded murder. 
(1) His body is lying in cold blood. 

(2) The police could investigate the 
cold condition of his murder. 

4463119 246319 

(3) His ill got wealth may have led to 
an unprovoked murder. 

(4) None of the above. 

The lady officer's maiden speech waso 
inspiring to the community. 
(1) The lady was a bachelor, so her 

maiden speech was inspiring. 
(2) The audience were moved by her 

first speech. 

44
3179 43119 

was fresh to hear. 
(3) The inexperienced maiden's speecho 

(4) None of the above. 

PT.0. 
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Direction : Question Nos. 14 to 16 there are 
sentences which are divided and numbered into 

three parts and one of the parts may contain 

Loan error. Identify the error by (1), (2) or (3) 
given under the parts of the sentences. If there 

is no error, mark (4) no error. Shade/blacken 

Othe corresponding circle in your Answer Sheet. 446311 
4463119 
15 4463119 

4463119 

The foreigner quickly realized that / 

rice is grown / all in India. / No error. 

3 2 

Indians do not play good cricket / 

on foreign fields / 

2 

3 

1 

L-52-1 R 

like the Australians can. / No error. 

3 

1 

hardly. / No error 

1 

You cannot pass tests /until you work / 

4 

4 

4 

2 

5 

Direction : Read the following passage and 
answer the questions that follow (Question 
Nos 17 - 20). Your answers to the question 
should be based on the passage only. 

Passage 
Global warming has become a major 

problem. The cars we drive release gases into 
the air that make it warmer. Forest fires to 
clear the land also lead to global warming. 
Industries release effluents and poisons into 
soil and water. The effects are alarming. The 
climate has changed and the weather is hotter. 
The level of ocean is rising, because the ice is 
melting. Countries are now thinking of ways 
to stop global warnming. But humanity has not 
yet begun reinventing the modes and structures 
of progress. This living planet earth is dying. 

17 

19 

20 

(1) threatening (2) frightening 
different (4) confusing (3) 

18 The 
(1) 
(2) 

Alarming" means 

(3) 
(4) 

major reason for global warming: 
vehicular traffic 
forest fires 

industrial effluents 
All of the above 

The level of ocean is rising because of 
(1) Industries (2) Cars 

(3) Ice melting (4) Forest fires 

"reinventing" means 
(1) remaking (2) applying 
(3) repeating (4) rejecting 

P.T.O. 
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Direction: For Question Nos. 21 to 23 a word/ 
phrase is given followed by four options. 
Choose the option which explains the correct 
meaning of the word/phrase and shade/blacken 
the corresponding circle accordingly in your 
Answer Sheet. 

21 Infallible 

22 

(1) incorrigible 

(2) fallacious 

(3) without infamy 

(4) committing no errors 

Verbose 

(1) Malapropism 

(2) Full of verbs 

(3) Full of vibes 

(4) Too wordy 

23 Ecocriticism 

(1) Theory of biome 

(2) Critical awareness of man's relation 
to nature 

(3) Study of conservation and 
desertification 

(4) All of the above 

L-52-1_ R 

Direction : Fill in the blanks with appropriate 
prepositions for the given sentences, choosing 
from the options given below from Question 

Nos. 24 and 25. 

24 

25 

6 

26 

The treckers went 
set for them. 

(1) on 

(2) besides 

(3) into 

(4) beyond 

The strange scene was captured 
the camera. 

(1) with 

(2) by 

(3) at 

(4) on 

given below: 

Sitara was 

college during that period. 

(1) a 

Fill in the blank with appropriate option 

(2) an 

(3) the 

the limits 

(4) zero article 

4463119 
4463119 

4463119 
4463119 

principal of the 
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Direction : Question Nos. 27 to 29 have an 

sod expression, each of which can be replaced by 

a single word. Choose the most appropriate 
word from the alternatives and shade/ blacken 
the corresponding circle in your Answer Sheet. 

4463119 
4463119 
4463119 

4463119 
4463119 

27 

28 

29 

considered religious 

Action violating the sanctity of things Answer Sheet. 

(1) Atheism 

(2) Sacrilege 

(3) Bigotry 

(4) Nihilism 

One who believes in the pre-determined 

destiny 

(1) Pessimist 

(2) Idolater 

(3) Fatalist 

(4) Cynic 

A good appreciator of art, food, wine etc. 

(1) Gourmet 

(2) Connoisseur 

(3) Gluttonous 

(4) Philanthropist 

Direction:Question Nos. 30 and 31 are based 

on degrees of comparison (positive, 
comparative and superlative). Fill in the blanks 
with the most appropriate word / words from 

L-52-1_R 

among the alternatives and shade/blacken the 

corresponding circle accordingly in your 

31 They reached the place as quickly as 

31 

(1) feather 

(2) pigeons 

(3) lightning 

(4) soldiers 

Some Indians speak English 

than the native speakers. 

(1) sweetly 

(2) incoherent 

(3) faster 

(4) masterfully 

PT.0. 
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Direction : Choose the synonyms for the given 

underlined words (Question Nos. 32 and 33) 

Direction : Choose the antonym or the most 

opposite in 'meaning to the underlined word 

and shade/blacken the correct answer in your(Question Nos. 34 and 35) and shade/blacken 
Answer Sheet. 

32 

33 

The holy man's personality inspires awe. 

(1) Awkwardness 

(2) Reverence 

(3) Obstinacy 

(4) Distinctness 

Can you be so impertinent toward an 

elderly woman? 

(1) Shouting 

(2) Sickly 

(3) Rude 

(4) Indifferent 

L-52-1_R 

the correct answer in your Answer Sheet. 

34 Can I be discourteous to my benefactors? 

(1) II-behaved 

(2) Polite 

(3) Obedient 

(4) Silent 

35 The old man seems too feeble. 

(1) Unable 

(2) Strong 

(3) Active 

(4) Unfirm 

P.T.0. 
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36 

4463119 446319 

4463119 38 

39 

åAOT•``oie'g? 

(1) Srdne - es odte,A bad jcbasd 

(2) doRrey -Bnd dodd a3abd Tadß 

(3) Jarten - ob Seddo dAODd 

(4) aiotso -odYrties� aoI)Rr 

(1) BOzs•obJdo- bebsdd 00 

(2) JeeT•dd- ob3e 

(3) sBBobsdo- deeDT•T og �ea 

(4) riaatsd oodortegd 

(1) 3 

(3) &eoE 

(1) ese3 

(3) eots 

L-52-1 R 

(2) abe 

(4) aior eo 

(2) 

(4) aabe 

40 

41 

42 

43 

(1) Jesb 

(2) td aott 

(3) Jo8 oes odja 

(1) z 

(3) 

(1) 

(ii) d Jeod 

(2) 

(4) d 

(iv) dodod doaod 

(1) i, ii dog (2) i, ii, ii aod 

(1) sddedeo 

(3) i, ii, iv aod (4) i, ii, ii, iv 

(2) g 

(3) seaED (4) sagee 

P.T.0. 
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44 

45 

46 

47 

48 

(1) orsYE S 
(3) evsiedE J• (4) 

(1) Sp•s 

(3) 200ed 

a) 

b) 

c) 

d) 

åOONIoien3? 

(4) aio}io O 

(2) 

(1) eðJ od so, 

(1) 5•obe 

(3) d3 

(4) 

(2) eR dd Gohieo 

(3) abbd 

(2) AU 

33e 

(3) eðJ hoco egohriso 

L-52-1 R 

(2) 

(1) 3d (2) 

(4) 

epDE OBd 

Jo 

(4) 

e Boåoees 

49 

50 

51 

52 

10 

(1) 

(3) obe zop 

(1) 

(2) 

(3) 

oa Baor 

(4) iabå Bao 

(1) $asSt 

(3) Jgax 

(3) 

waro taYr 

8tepodob daios 

(1) �ag da 
(2) ugoo da 

(1) 

(3) 

(2) 

(4) de d 

(4) 

Bo 

(4) Beta 

•R0 KOQ 

(2) atod 

P.T.0. 
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54 

55 

56 

57 

ae98 2: Bodora deEosod 

(3) 

(1) 

(4) e& 2 0, deO&l 33, 

(3) 90Dd) 

(1) 

BeO8- 2 seO8-1 & 300io 3os 

erUtJDBd`oie'g? 

e8 1 30, Be8-2 33, 

(1) 

(3) 

(3) eAdAd (4) ooade 

(2) Jobs 

L-52-1 R 

(2) 

ob 
(4) JOo 38 

(4) 

39 sd o 

(2) abYdbeJD0 

11 

59 

60 

61 

62 

(1) 9J•LDI 

(3) £des (4) Boo 

JdowT® 1, 2023 a "iNbd dsYE b3d 

(1) 

(2) 

o 

(3) a.ON°.&8E 

cberioed JOt•aDEO0DEIS 

(4) dao deoN 

(3) o ß 

(3) 

(1) o ao 

(2) 3ojos 

ieI 

(1) dodbbot 

(4) di- sod 

(2) 
(4) 

(2) 

ogeb tsYrt 
tbd taos 

(3) od hrt (4) Detad b 

PT.0. 
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63 

64 

65 

66 

(1) eCR JOdI 

(2) $n sosdRsåoe 

(3) 

(4) ai3S Wd) 

(1) o•A•ObN (2) Js• abJ� 

(3) o8• OtoJe (4) UORObN 

(1) deoo 

ews B8Tr 

(2) ad�oce ha•d,Jsoo 

(3) 

(4) &3&JORd) 

P. 

Q. 

R. 

(1) PRQS 

(3) PQRS 

L-52-1_R 

(2) RPQS 

(4) RQPS 

67 

12 

68 

69 

70 

(1) �ozod dodo ab 

(2) 00aa 

(3) 

(4) 0ip`Toao 

BAODI0BaiY'o? 

(1) oR 
(3) - oe 

(1) 

(2) 

(1) eviNOe 

(2) 

(3) a y 

(4) 

(3) Yage ab•ODOH 

3- too 

evSE- Rbd, 

4463119 4463119 

4463119 
4463119 
4463119 
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71 Match the MS Word shortcut keys with 72 
their actions: 

Shortcut Key 
A. Ctrl + Shift + L 1. Apply 

B. Ctrl +E 

C 

Action 

2. Center align 

B. Ctrl +E 

bullet points 

Ctrl + Shift + > 3. Increase 

D. Ctrl + Shift +< 4. Decrease 

the selected text 

(1) A-1, B-4, C-3, D-2 
(2) A-4, B-3, C-2, D-1 
(3) A-3, B-2, C-4, D-1 
(4) A-1, B-2, C-3, D-4 

L-52-1 R 

font size 

A. Ctrl+ Shift +L 1, Dde® 

font size 

A-4, B-3, C-2, D-1 

(3) A-3, B-2, C-4, D-1 

2. esom, doded 

C. Ctrl + Shift + > 3. od ogda 

D. Ctrl + Shift + < 4. ed rogd 

(1) A-1, B-4, C-3, D-2 

(2) 

(4) A-1, B-2, C-3, D-4 

13 

Which of the following formulas in MS 
Excel can be used to find the nth largest 
value in a range? 

(1) -LARGE (A1:A10, n) 
(2) MAX (A1:A10, n) 
(3) -RANK (A1:A10, n) 

(4) 

(1) LARGE (A1:A10, n) 
(2) -MAX (A1:A10, n) 
(3) -RANK (A1:A10, n) 

=VLOOKUP (n, Al:A10, 1, 
FALSE) 

73 The 

(4) =VLOOKUP (n, Al:A10, 1, H 

(1) 
(2) 

function returns the 
smallest value in a range that meets 
multiple criteria, whereas the 
function returns the largest value in a, 
range that meets multiple criteria in MS 
Excel. 

(3) 

FALSE) 

SMALLIFS, LARGEIFS 
MIN, MAX 
MINIFS, MAXIFS 

(4) IFMIN, IFMAX 

(1) SMALLIFS, LARGEFS 

4463119 4463119 

(2) MIN, MAX 

(3) MINIFS, MAXIFS 

44631ig 

(4) IFMIN, IFMAX 

446311 

P.T.0. 
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74 

75 

How do you apply double line spacing | 76 
to a paragraph? 
(1) Home > Line and Paragraph 

Spacing > 2.0 
(2) Layout > Line Spacing > 2.0 
(3) Design > Line Spacing 
(4) Insert > Line Spacing > 2.0 

(1) &oso > eb eoreaRor 

(2) SeBes > 
(3) so > 
(4) 

> 2.0 

asAE > 

2.0 

AOn> 2.0 
eort® > 2.0 
a eROre > 2.0 

Consider the following statements: 
Statemnent 1 : The "Home" tab in 
PowerPoint contains options to insert text 
and images. 

L-52-1 R 

Statement 2 : The "Insert" tab is used 
for adding elements like charts, tables 
and pictures. 
Which of the following options is correct 
regarding the above two statements? 
(1) Both Statements are correct 
(2) Only Statement 1 is correct 
(3) Only Statement 2 is correct 
(4) Both Statements are incorrect 

(1) odo Betrio (1 2) 30aiton 
(2) &ede te8 l o, O 
(3) &eado aeo8 2 in3 RO 
(4) oddo Bevtieo Jo 

77 

14 

In Microsoft PowerPoint, themes can be 
found under? 

(1) Design tab 

(2) Transition tab 

(3) Insert tab 

(4) Animation tab 

(1) 

(2) 

(3) 

(4) 

The 

° ee 

e ka,a9 

at°E &,23 

beBS s,2 

keyboard shortcut is used 
to insert a new comment in the existing 
presentation slide? 

(1) Ctrl+Alt+M 

(2) Shift+Alt+M 

(3) 

(3) Ctrl+Shift+M 

(4) Shift+M 

(1) Ctrl+Alt+M 

(2) Shift+Alt+M 

Ctrl+Shift+M 

(4) Shift+M 

P.T.O. 
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79 

Identify which of the following is not 
the primary role of an operating system? 
(1) Process management 
(2) 
(3) 
(4) 

(1) 

Database management 
File management 
Memory management 

(2) seER2eT® e,Jesots 
si,desotso 

(3) osi,Jesbote 
(4) oO ddeshOtT? 

Based on following statements, choose 
correct answer: 

Statement 1: Styles in MS Word can be 
used to ensure consistent formatting 
throughout a document. 

(3) 

Statement 2 : Styles can only be applied 
to headings and not to regular paragraphs 
or other elements. 

(1) Both Statements are true 
(2) Both Statements are false 

Statements 1 is true and Statement 
2 is false 

(4) Statements 1 is false and Statement 
2 is true 

ae©8 1: J0.SA.JoEIOR8orieg o 

L-52-1 R 

(1) Jdas de&io zoao'. 

(2) odio BeBio dsen. 
(3) Be8 1 z0 bd de8 2 
(4) aeO8 1 3, Jb3 de8 2 z0 

80 

15 

81 

is used to create personalized 
letters for multiple recipients. 
(1) Index 

(2) 

(3) Mail Merge 

(4) 

(2) 

(1) a0�a 

Table of contents 

(3) ee® 3® 

(4) o,abot® a 

Document Map 

To apply a header or footer that appears 
on every page ofa Word document, you 
use the tab and select 

(2) 

(1) Layout, Header and Footer 

Insert, Header and Footer 

(3) 

(4) 

(3) 

Design, Page Numbers 

Page Layout, Header 

(2) aesE, so® ab jo&JT® 

O. jS BOalriso 

(4) e3 Dse, Bdo® 

P.T.0. 
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82 The smallest unit of data in a computer 84 
and is a program 

83 

1s a 

that protects a computer from viruses. 

(1) Bit, Antivirus 

(2) Byte, Operating System 
(3) Nibble, Antivirus 

(4) Giga Byte, Firmware 

(1) 

(2) ej8, eddeElor® Aigao 

(3) Jge, osgd 
(4) 

Choose True or False respectively for the 
following statements: 

Statement 1: A mouse is an input device. 
Statement 2: RAM is a nonvolatile 

memory. 

(1) True, True (2) 

(3) False, True (4) 

�eB -2: v,iyo (RAM) aiod ISrnd 

(nonvolatile ) boDaie'd. 

(1) z0, 30 

(3) J, zO 

True, False 

False, False 

L-52-1 R 

(2) 30, B, 

(4) d, do, 

16 

85 

Which of the following controls the 
degree of multi-programming in the 
operating system? 

(1) Multiplexer 

(2) Dispatcher 

(3) Long term scheduler 

(4) Medium-term scheduler 

(1) io 

(2) ao® 

(3) cOOr® t3°E Baaoos 

(4) oeabto s3ieE Baaoo® 

In the Windows operating system, the 
maximize button, the minimize button 
and the close buttons of any window 
appear on? 

(1) Title bar 

(3) Menu bar 

(2) Tool bar 

(3) o TS 

(4) Status bar 

(1) &363ETË 2NOË (2) 63oOF 2DU 

P.T.0. 
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86 Based on the following statements choose 87 
the correct answer: 

Statement 1: CC recipients are hidden 
from other recipients. 

Statement 2 : BCC recipients are visible 
to all recipients. 

(1) Statement 1 is correct, whereas 
Statement 2 is incorrect 

(2) Statement 1 is incorrect, whereas 
Statement 2 is correct 

(3) Both Statement 1 and Statement 2 
are correct 

(4) Both Statement 1 and Statement 2 
are incorrect 

ae% 1: CC eaaeo ao aeåde doriood 

Roeesdorbgdosgd. 

(1) te<8 1 z0aYAd SOO Be82 dze 

(2) &eO8 1 Be, æ BeO8 2 BOaYnd 

(3) e8 1 b teO8 2 tao 3OobYn 

(4) Be8 laba teo8 2 addo dnn3 

L-52-1_R 17 

88 

Which option is used to create a drop 

cap? 

(1) Home > Drop Cap 

(2) 

(3) 

(4) 

(1) &eao > seo Be,o 

the 

Insert > Drop Cap 

(2) asEE > , te, 

(1) 

Layout > Drop Cap 

(2) 

Design > Drop Cap 

An email signature is typically placed af 
of an email. 

(1) 

Beginning 

Middle 

(3) End 

(4) None of the above 

(2) s 

oridgdgd. 

dojd 

(3) &osob 

4463119 4463119 

44%3119 
463119 
4463119 
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89 Which network topology is most 
susceptible to single point of failure? 
(1) Bus 
(3) Mesh 

90 

(1) JJ® 

(3) y 

engines. 

(1) 

Fill the blank spaces in following 
statements with correct words: 

Statement 1 : The primary function of a 
is to index web pages for search 

(2) 

Statement 2: A is a software 

application used to access and view web 
pages. 

(4) 

(2) Ring 

Web Crawler, Web Browser 
Web Browser, Web Crawler 

(3) Boot Loader, Web Crawler 

(4) Star 

BeO8 1: 

(2) dor® 

Be0% 2: 

(4) 0® 

L-52-1_R 

Operating System, Web Browser 

(3) 2ts® oeo®, Ba B•,O 

(4) essdeesor® A, de 3oj09 

91 

92 

93 

18 

address changes automatically 
and is assigned by'a DHCP server. 
(1) Static IP 
(2) Dynamic IP 
(3) MAC 
(4) Both Static ahd Dynamic IP 

(3) MAC de 

is used for accessing web-based 
email services whereas is used 

to send emails to a mail server. 

(1) FTP, IMAP (2) DNS, FTP 
(3) NTP, IMAP (4) HTTP, SMTP 

dabe 20åoo, 

(1) FTP, IMAP (2) 
(3) NTP, IMAP (4) 

DNS, FTP 
HTTP, SMTP 

Which of the following techniques is 
used to disguise the sender's identity in 
an email? 

(1) Sniffing (2) Spying 
(3) Spoofing (4) Decrypting 

(1) on® 
(3) ieorn® (4) a&on 

(2) or® 

P.T.O. 
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94 Which of the following is the correct 
sequence of, the computer's data 
processing cycle? 

95 

(1) Input, Output, Processing, Storage 
(2) Input, Processing, Output, Storage 
(3) Processing, Input, Output, Storage 
(4) Storage, Input, Processing, Output, 

(2) a°ju°, or®, 83$, RQrdes 
(3) 9Aor®, a°o, Be jE°, gSdeso 

(4) sgrdeas, a*jts, okor, 8fHES 

Select the correct set of Input Devices 
when A, B, C, D are the given sets: 
A. Keyboard, Scanner, Speaker, 

Joystick 
B. Joystick, Touchscreen, Mouse, 

Microphone, 
C. 

D. Keyboard, Plotter, Monitor, Speaker 
(1) A, B 

(3) C, D 

A. 

B. 

C. 

Mouse, Scanner, Light Pen, Web 
Camera 

A, B, C, D ocarissa JeDTri a°jeTS 

D. 

(1) A, B 
(3) 

L-52-1 R 

(2) B, C 

C, D 

(4) A, D 

B,C (2) 
(4) A, D 

19 

96 Based on the following statements, 
choose the correct answer: 

Statement 1 :A compiler translates high 
level language code into machine code. 

Statement 2 : An interpreter translates 

high-level language code line by line. 

(1) Only Statement 1 is true 

(2) Only Statemnent 2 is true 

(3) Both Statements 1 and 2 are true 

(4) Neither Statement 1 nor Statement 
2 is true 

Beot 2: o a830°B,830$, v 

(1) &eae BeOI -1 30 

(2) &o de8-2 3O 

(3) �e8 -1 b �e8 -2 ddo NOoion 

(4) see8 -1 ede Be8 -2 adde TO 

P.T.0. 
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Which functions in MS Excel searches 
for a value in the first row of a table and 
returns a value in the same column from 

a specified row? 

(1) VLOOKUP (2) HLOOKUP 
(3) INDEX (4) MATCH 

(1) VLOOKUP (2) HLOOKUP 
(3) INDEX (4) MATCH 

Pivot Tables and Pivot Charts is used in 
MS Excel for 

(1) Filtering data; sorting data 
(2) 

and 

Creating data entry 
automating data entry 

(3) Creating dashboards; managing 
large data sets 

forms; 

(4) Summarizing data; visualizing 
summarized data 

L-52-1 R 

(1) dsoð toeji, isaod Jortded 

(2) do8 3d8 aosid ; 

(4) d•oB OODOB¢Bde•; 5O0DODe3OReDH 

dogodd ,eddeortoDSd) 

20 

99 TCP is a 

(1) Connectionless, Connection 
oriented 

(2) Connection oriented, Connection 
oriented 

protocol. 

(3) Connection oriented, 

(4) Connectionless, Connectionless 

TCP obo 200 

UDP obo 2o 

(2) 

Connectionless 

(3) 

(1) aoaE dbdd, sOBde dodod 

(4) 

protocol, UDP is a 

3oÝe RodRd, BoBèe dodaed 

(3) 

odie doded, RodBEdbdaad 

3odåE Ja3oi, BoE Ja3•3 

100 The process of breaking down data into 
smaller packets for transmission over a 
network is called: 

(1) Segmentation 
(2) Encapsulation 
(3) Multiplexing 
(4) Franming 

(1) JonB3d 

(2) sorodjad 

20•jro3o 

(4) doSDII 

P.T.0. 
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